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In this section:

Working in 
Office 2010

n	 What’s What in Office 2010?

n	 Using the Ribbon

n	 Using Galleries and Lists

n	 Using Shortcut Menus and Dialog 
Boxes

n	 Using Only the Keyboard

n	 Moving and Copying Content

n	 Working with Backstage View

n	 Getting Help

n	 Saving Your Work

n	 Office’s File Formats

In this section of the book, we’ll discuss the various programs in 
Microsoft Office 2010—their similarities and differences, and 

the ways they work separately and together. Depending on which 
version of Office you’re running, you might have some or all of 
the programs installed on your computer. All the Office programs 
have elements in common—namely, the ribbon and Backstage 
view. The ribbon brings you all the tools you need by displaying 
them in tabs and tab groups across the top of the application 
window. You can customize the ribbon in Office 2010 to create 
your own tabs and tab groups. And Backstage view enables you to 
easily create, open, print, save, and share files by pulling together 
all the file management tools in one easy-to-use window.

This chapter focuses on these two common features avail-
able throughout the Office 2010 applications, and it introduces 
you to the various tools and procedures you’ll use to navigate 
the programs using both the mouse and the keyboard. Along the 
way, you’ll learn how to use the dialog boxes you discover, work 
with shortcut menus you display by right-clicking an element, 
use keyboard shortcuts to speed up your work, use Paste with 
Live Preview to paste copied information just the way you want 
it to appear, and use various Help features to learn more about 
tools and tasks in Office 2010.

2
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What’s What in Office 2010?
There are a number of versions of Microsoft Office 2010 avail-
able for users with differing needs. If you work with Office 2010 
in a large corporate setting, you may be using Office Profes-
sional Plus 2010, which includes a larger number of Office appli-
cations than, say, Office Home and Business 2010. Here’s a quick 
rundown. Find your version in this list so that you know which 
programs are likely to be available in your copy of Office 2010:
n	 Office Professional Plus 2010 brings together all the 

applications, with an emphasis on connectivity and 
mobility. In this version, you’ll find Word, Excel, Outlook, 
PowerPoint, Publisher, Access, OneNote, InfoPath, 
SharePoint Workspace, and Communicator.

n	 Office Professional 2010 focuses on functionality by 
including the more popular programs, including Word, 

Excel, Outlook, PowerPoint, Publisher, Access, and 
OneNote.

n	 Office Home and Business 2010 offers the reliable standard 
applications to home and small business users who need 
power and dependability but aren’t likely to need data 
management or connectivity features. The programs in 
this version include Word, Excel, Outlook, PowerPoint, and 
OneNote.

The following list introduces you to the most common 
programs in Microsoft Office 2010 and gives you a brief 
description of each program’s purpose. Depending on which 
version of Office 2010 you have and whether you purchased 
any additional Office programs, you might have some or all of 
these programs installed on your computer. 
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Working in Office 2010
Microsoft Office 2010 Programs

Microsoft Access 2010 is a relational database program for 
storing, retrieving, and analyzing data.
Microsoft Excel 2010 is a worksheet program for organizing, 
analyzing, and graphing data.
Microsoft OneNote 2010 is an electronic note-taking pro-
gram for gathering, sharing, and organizing handwritten, 
typed, copied, drawn, or recorded notes.
Microsoft Outlook 2010 is an e-mail program and a great 
way to manage your contacts, tasks, and schedules.
Microsoft PowerPoint 2010 is a program for developing and 
sharing professional presentations.
Microsoft Publisher 2010 is a desktop publishing program 
for intricate placement of text and graphics on the printed 
page or on the Web.
Microsoft SharePoint 2010 is a program that enables you 
to create a shared workspace where you and team members 
can share files, create document libraries, discuss projects, and 
more. 

Microsoft InfoPath 2010 (Designer and Filler) is a set of 
two programs that make it easy to design effective forms and 
enter the data you want to collect.
Microsoft Word 2010 is a powerful word processing program 
for doing everything from writing a letter to writing a novel to 
creating mass mailings. 
Microsoft Office Tools are programs you can use in conjunc-
tion with the main Office programs:
n	 Microsoft Clip Organizer provides easy access to Clip Art 

and similar content. 

n	 Microsoft Office 2010 Language Preferences control 
the languages identified and used in your programs. 

n	 Microsoft Office Upload Center enables you to upload 
files to Web servers using the Microsoft Office Upload 
Center tool.

n	 Microsoft Office Picture Manager organizes, edits, and 
creates quick access to your pictures. 
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Using the Ribbon
All Office 2010 programs now use the ribbon to bring you the 
tools you need to create, work with, save, and share your files. 
The ribbon is organized in a similar way in all programs, orga-
nizing tools on tabs that reflect common tasks you want to 
complete in each application. For example, in Word, the tabs 
are Home, Insert, Page Layout, References, Mailings, Review, 
View, and Add-Ins. 

Within each tab, tab groups contain tools related to a spe-
cific aspect of that task. The Insert tab in Word, for example, 
includes tab groups for Pages, Tables, Illustrations, Links, Header 
& Footer, Text, and Symbols. When you want to add a picture 
to your Word document, you click the Insert tab and then click 
Picture in the Illustrations group to complete the task. 

Explore the Ribbon

	 1 	 Open any Office 2010 program.

	 2 	 Click a tab on the ribbon.

	 3 	 Click a button to execute a command.

	 4 	 Click a down arrow to open a gallery or 
a list, or click a dialog box launcher to 
open a dialog box.

	 5 	Point to an item in a gallery to see its 
effect on the content of your document.

	 6 	 Click an object in the program window.

	 7 	 Click the contextual tab that appears.

	 8 	 Click the tool you would like to use to 
work with the selected object.

2 1 Dialog box launcher

Gallery

3

4

5

8 7

The ribbon is composed of tabs, groups, and 
tools. When the ribbon is minimized, you see 
only the tabs. You can display the full ribbon 
by clicking a tab or pressing Ctrl+F1.

Tip

Read “Customizing the Ribbon“ on pages 392–393 if you’d like 
to learn how to create your own tabs and tab groups so that 
you can customize the ribbon for your Office 2010 programs.

See Also
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Set the Ribbon Display

	 1 	 When you begin using Office 2010, the 
ribbon is displayed by default. Hide the 
ribbon by clicking the Minimize The 
Ribbon.

	 2 	 Display the ribbon by clicking a tab. The 
ribbon appears until you click a tool or 
click in your document.

	 3 	 To redisplay the ribbon, click Maximize 
The Ribbon.

With the ribbon in its displayed state, double-click 
the active tab to minimize the ribbon, and then click 
any tab to display the ribbon temporarily. Click in 
your file to minimize the ribbon again. Double-click 
the active tab to have the ribbon always displayed. 
Press Ctrl+F1 to hide the ribbon, and press Ctrl+F1 
again to have the ribbon always displayed.

Try This!

1

2

3
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2
1

More
button

Selected object

Using Galleries and Lists
Each tab in an Office 2010 program offers you a different set 
of tools related to a specific task. The File tab, which contains 
Backstage view, and the Home tab, offering the most common 
tools, appears in all Office 2010 programs.

Within each tab you’ll find tab groups, displaying tools 
you can click to execute a command or display a gallery. The 
different lists and galleries offer you ready-made styles and 
options you can apply to the content in your document.

Explore the Galleries

	 1 	 In any Office 2010 program, locate 
a tab group that shows examples of 
styles or options you can select. You 
can also click an object in the file 
to display a contextual tab for that 
item.

	 2 	 Click the More button in the lower 
right corner of the display.

	 3 	 Point to the various choices in the 
gallery. The changes are previewed 
in your file. Click the option you 
want to apply.

Continue exploring the different 
tabs and galleries in this and other Office 
programs.

Some galleries also include commands you can click to 
continue your work with a specific object. For example, at 
the bottom of the Themes gallery in the Page Layout tab 
of Word and Excel, you’ll find the Browse For Themes and 
Save Current Theme commands. 

Tip

3
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Display Lists and Choose Commands

	 1 	 To display a list of commands on a tab, 
click any tool showing a down arrow.

	 2 	 On the displayed list, click a command 
with a right-pointing arrow to display 
additional choices for that command.

	 3 	 Click a command with an ellipsis (…) to 
open a related dialog box.

To close a list without executing a com-
mand, click outside the list.

Use the Tools

	 1 	 Point to a tool on the toolbar, and wait 
for a ScreenTip, showing the tool button’s 
name, to appear. 

	 2 	 Some tools have two parts: the tool 
button and a down arrow. The two parts 
of the tool are highlighted indepen-
dently. To apply the setting shown on 
the button, click the tool. To display a list 
of choices for that tool, click the down 
arrow.

	 3 	 If a tool button looks “pressed,” click it 
again if you want to turn off that feature.

1

3

2

123

Read “Customizing the Quick Access Toolbar“ on 
pages 394–395 for information about modifying 
the Quick Access toolbar in your favorite Office 
2010 applications.

See Also



16  Using Shortcut Menus and Dialog Boxes

Using Shortcut Menus and Dialog Boxes
Word 2010 also offers many shortcut menus and dialog boxes 
that provide additional ways to choose the tools and settings 
you need. You can right-click an object in your file to display 

a shortcut menu showing choices related to that object, and 
you can click dialog box launchers to display dialog boxes of 
options related to the task you want to complete.

1

2
Items that are gray on menus or toolbars are 
items that aren’t available at the moment. 
For example, if you haven’t selected 
anything, the Cut and Copy commands are 
gray because there’s nothing selected to cut 
or copy.

Tip

Use the Shortcut Menus

	 1 	Right-click any content or location 
in your program where you want to 
execute an action.

	 2 	Choose the action you want from the 
shortcut menu that appears.

You can use a shortcut key to choose a tool 
in a shortcut menu by typing the underlined 
letter in the tool you want to select.

Tip
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Working with Dialog Boxes

	 1 	 Click any command that shows an 
ellipses (…) or

	 2 	 Click a dialog box launcher in a tab 
group on the ribbon.

	 3 	 Choose the settings you want to apply 
to the item.

	 4 	 Click OK to save your changes.

1

2

4

Cancel your
changes

Display a different
dialog box

Preview your
changes

Click the tab you want to use

Click to display
a list of choices

Type a value or use the arrows to
increase or decrease the value

3



18  Using Only the Keyboard

Using Only the Keyboard
If you prefer to keep your hands on the keyboard instead of 
using the mouse, you can do almost everything using Office 
and program-specific keyboard shortcuts. By activating the 
command tabs and the ribbon, you can use the displayed keys 

to navigate and to execute commands and activities. There are 
also many keyboard shortcuts you can use to execute some of 
the most common commands and activities.

Browse the Ribbon with Your Keyboard

	 1 	 Press and release the Alt key to display 
the KeyTips for access to the tabs and the 
ribbon.

	 2 	 Type the letter for the tab you want. You 
can also type the number for any item on 
the Quick Access toolbar or to open the 
Office menu.

	 3 	 Type the letter or the keyboard shortcut 
to access the item you want on the ribbon. 
If a gallery or a drop-down menu appears, 
use the arrow keys to select the item you 
want, and then press Enter.

If you decide you don’t want to execute an 
action after you’ve pressed the Alt key, press 
the Alt key a second time to return to your 
work.

Tip

2

3
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Read “Getting Help” on pages 24–25 for 
information about using Office 2010’s Help 
system.

See Also

Use Keyboard Shortcuts

	 1 	 Use the keyboard shortcuts shown in the table at the 
right to execute the action you want. Not all shortcuts 
are appropriate for all programs all the time.

	 2 	 If you want to switch from mouse methods to key-
board methods, point to the button or other item you 
want to work with, and note the keyboard shortcut in 
the ScreenTip. Then use that keyboard shortcut.

	 3 	 If you don’t see the keyboard shortcut you want in 
the table or in a ScreenTip, search Help for “keyboard 
shortcuts.”

Common Keyboard Shortcuts
Action Keyboard Shortcut
Copy and delete (cut) selected content Ctrl+X
Copy selected content Ctrl+C
Paste content Ctrl+V
Hide or minimize ribbon Ctrl+F1
Apply/remove bold formatting Ctrl+B
Apply/remove italic formatting Ctrl+I
Apply/remove underline formatting Ctrl+U
Align paragraph left Ctrl+L
Align paragraph center Ctrl+E
Align paragraph right Ctrl+R
Add/remove space before paragraph Ctrl+0 (zero)
Apply double line spacing Ctrl+2
Apply single line spacing Ctrl+1
Apply Normal style Ctrl+Shift+N
Change case Shift+F3
Undo last action Ctrl+Z
Redo last action Ctrl+Y
Open shortcut menu Shift+F10
Check spelling F7
Save document Ctrl+S
Save As F12
Print (show Print dialog box) Ctrl+P
Open Help F1



20  Moving and Copying Content

Cut or Copy Information

	 1 	 Select the text you want to cut or copy.

	 2 	 Do either of the following:

	 Click the Cut button (or press Ctrl+X) to 
delete the selected text and store it on the 
Clipboard.

	 Click the Copy button (or press Ctrl+C) to 
keep the selected text where it is and place 
a copy on the Clipboard.

Read “Customizing Your Editing“ on page 398 for 
information about modifying the default settings for 
the way items are cut and pasted in your document. 

See Also

You can use the Office Clipboard to store items other 
than text, including pictures, tables, objects, and even 
data from Excel 2010 worksheets or Access 2010 data 
tables.

Tip

Moving and Copying Content
Office programs, and most other programs, use a tool called 
the Clipboard as a temporary holding area for content that you 
want to move or copy to another part of your document, to 
another document in the same program, or to a document in 
another program. You simply park your text on the Clipboard 
and then, when you’re ready, you retrieve it and “paste” it into 
its new location. One of the challenges with the Clipboard 
is that the format of information you copy and paste can be 
unreliable—one time you get the right font and color for a 

heading, for example, but the next time you don’t necessarily 
get the result you wanted.

Now Office 2010 includes the Paste with Live Preview 
feature, which enables you to control how the information you 
copy is pasted into your file. Depending on the type of infor-
mation you’ve copied—text, numbers, pictures, or objects—
you are given a series of choices for the way the information is 
pasted. And what’s more, you can preview your choice before 
you selected it. Nice.

12

Text copies to
the Clipboard
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Paste Information Using Paste with 
Live Preview

	 1 	 Click in your document where you want to 
insert the information.

	 2 	 In the Clipboard group of the Home tab, 
click the Paste button.

	 3 	 Hover the cursor over each paste option 
to see how the information will look at 
the selected position. Click the option you 
want to apply.

	 4 	 You can change the format of the pasted 
information by clicking the Paste Options 
button and choosing the option you want 
to use.

2
3

1

4

Copy and Paste Multiple Items

	 1 	 Display the Clipboard by clicking the 
dialog box launcher in the Clipboard 
group on the Home tab.

	 2 	 Click the item to be inserted. Click Paste.

	 3 	Click Clear All to empty the Clipboard.

3

2

1
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Working with Backstage View
All the tools you need to create, save, share, and choose 
options for your Office 2010 files are now available in Back-
stage view. This convenient view presents the various com-
mands as tabs so that you can easily find the task you want to 
complete and choose the options you need associated with it. 

When you first click the File tab, Backstage view appears 
and the Info tab is displayed. This tab displays the file’s 

properties and authors, and gives you access to the commands 
you need to set permissions, prepare to save the file, and 
work with file versions. Other tabs in Backstage view—such 
as Recent, New, Print, and Save & Send—give you access to 
existing and new files and help you print and share the files 
you create. Additionally, you set program options and get Help 
in Backstage view. 

Finding File and Program Information

	 1 	 Click File to display Backstage view.

	 2 	 Review the file’s properties.

	 3 	 Choose the tools you want to work with in 
the center of the Backstage view window.

To close Backstage view and return to your 
file, click the File tab a second time.

Tip

Click Manage Versions in the Info tab of Backstage 
view and choose Recover Draft Versions. A dialog 
box opens showing unsaved versions of your file 
so that you can open and save the content. In this 
way, you can recover information that you might 
have accidentally forgotten to save.

Try This!

1 2

3

Common file tasks

Recently views files
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Printing a File

	 1 	 In Backstage view, click Print.

	 2 	 Set print options in the center of the Print 
window.

	 3 	Preview the file by clicking the arrows 
near the page number at the bottom of 
the document preview to move through 
the document.

	 4 	Drag the Zoom slider to change the size 
of the document display.

	 5 	Click Print to print the file.

5

1

2 3 4

You can print a document directly to a 
OneNote 2010 notebook by clicking the 
Printer setting arrow and choosing Send To 
OneNote 2010. When the Selection Location 
In OneNote dialog box appears, choose the 
notebook and section where you want to 
insert the document and click OK.

Tip

The tools available in Print Settings vary 
from application to application.

Tip

In Word, you can click the Print All Pages arrow (the first item under 
Settings), and choose the pages you want to print. If you want to 
print on both sides of the page but your printer doesn’t support 
dual-sided printing automatically, you can do it manually by click-
ing Print All Pages and choosing Only Print Odd Pages. Click Print to 
print the pages, and then remove them from the printer, make sure 
they are in sequential order, and then put them back in your printer 
to print the even pages. Click Print All Pages again, and this time 
click Only Print Even Pages and click Print.

Tip
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Getting Help
Nothing can replace this book, of course, but Office 2010 
does provide you with other resources to help solve prob-
lems you might encounter. We’re using Word Help here 
to illustrate the ways you can get help in all your Office 
programs. 

1

2

5 46

3

Browse for Help

	 1 	 In your program, press 
the F1 key to display the 
Help window for that 
program.

	 2 	 Click a category that 
reflects what you want to 
learn.

	 3 	 Find what you want to 
do, and then click the link 
that seems relevant to 
your question.

	 4 	 If the font size is too 
small or too large, click 
the Change Font Size 
button, and choose a 
font size from the menu.

	 5 	 To print the topic, click 
the Print button.

	 6 	 To return to either the list 
or the articles, click the 
Back button. To return to 
the list of categories, click 
the Back button again.
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Search for Help

	 1 	 Type your Search text.

	 2 	 If you want to specify which Help resources you 
want, click the Search down arrow, and then click the 
resource.

	 3 	 Click Search.

1

3

2

4

6

5

	 4 	 Click a search result that seems relevant. 

	 5 	 If there’s more than one page of results, click the Next 
button at the top and bottom of the search results to 
see any additional pages.

	 6 	 Close the window when you’ve finished.



26  Saving Your Work

Saving Your Work
While you’re working on your document, you’ll want 
to save it frequently to make sure that it’s preserved 
for posterity—or at least until you’ve completed it, 
printed it, or shared it with others for review. After 
you’ve named and saved the file, the Save As dialog 
box won’t appear for subsequent saves.

Save the File 

	 1 	 In Word, Excel, PowerPoint, and Publisher, you 
can click the Save button on the Quick Access 
toolbar. In OneNote, your information is saved 
for you automatically. And in Access, the file 
is saved automatically when you create it, 
although you can click the Save button to save 
individual items, such as a new table.

	 2 	 Type a name for the file in the File Name box 
if you don’t want the name that the program 
proposes. File names can be as long as 
250 characters and can include spaces, but you 
can’t use the \ / * ? < > and | characters.

	 3 	 If you’ll always want to save the file to your 
default location, click Hide Folders. 

	 4 	 If you don’t want to save the file in the sug-
gested format, select the format you want.

	 5 	 Click Save.

2
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In some applications, like Word 2010, you 
will also see the Save Thumbnail check box. 
Click this box if you want to see a preview 
of the file in a folder window.

Tip

After you save the file, continue to work on 
it as needed, saving your work frequently 
by clicking the Save button or pressing the 
keyboard shortcut Ctrl+S.

Tip
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Office’s File Formats
Beginning with Office 2007, Microsoft Word, Excel, Power-
Point, and Access saved files in a different format that was 
more efficient and flexible than the format used in previous 
versions. Some people you trade files with may be using dif-
ferent versions that produce files in different formats than the 
program you are using in Office 2010. Fortunately, you can 
save your Office 2010 files in earlier formats if this is a prob-
lem for you, or you can get a file converter (available from 
Microsoft Downloads) that enables your friends and colleagues 
to view and work with Office 2010 files.

If you decide not to use the latest formats available in the 
various Office 2010 applications, however, be aware that you 
won’t be able to use some of the programs’ very cool new fea-
tures. For example, features such as video styles in PowerPoint 
or text effects in Word will not be available to you. Review 
the following descriptions of the formats used in Word, Excel, 
and PowerPoint to see which formats work best for you. To 
see the list of all available formats, choose Save As from the 
Office menu, and, in the Save As dialog box, scroll through the 
Save As Type list. To see a description of the Access file format 
choices, see “Open an Existing Database File” on page 367.
n 	 Document, Workbook, or Presentation  This is a 

format that was new with Office 2007 that enables all of 
the programs’ new features. Files in this format can’t be 
opened in earlier versions of their respective programs 
unless you’ve downloaded and installed a special 
translating filter program. The new format has the standard 
file extension with an added “x” (for example, .docx, .xlsx, 
.pptx). 

n	 Macro-Enabled Document, Workbook, or 
Presentation  This is the same format as the Document, 
Workbook, or Presentation format, except that it contains 
macros. 

n	 XML Document or Presentation  This is a plain Text file 
that includes all the text and the XML coding. This format is 
used primarily in a corporate setting where transforms are 
created to extract and/or reformat information that will be 
stored for reuse.

n	 Word, Excel, or PowerPoint Template  This new form 
of template, first available in Office 2007, also enables the 
new features of the program.

n	 Word, Excel, or PowerPoint Macro-Enabled 
Template  This is the same format as the Template 
format, except that it can contain macros.

Other File Formats for Office Programs

n	 Word, Excel, or PowerPoint 97–2003 format  This 
is the binary file format used in previous versions of 
these programs. Although it provides compatibility with 
earlier versions, saving in this format disables some of the 
advanced features of the 2007 programs.

n	 Word, Excel, or PowerPoint 97–2003 Template  This 
is the binary file format for templates used in previous 
versions of Word.

n	 Single File Web Page  This format creates a Web page 
and stores all the graphics in the same file.

n	 Web Page  This format creates a standard HTML-format 
Web page whose graphics are stored in a separate folder.

n	 Rich Text Format  This is a binary file that contains the 
text and formatting information but little else. It provides 
compatibility with many programs.

n	 Plain Text  This text file contains only the text of the 
document and no formatting.
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n	 Numbering Headings and Lines

n	 Inserting a Cover Page

n	 Inserting Information with Additional 
Actions

n	 Inserting an Equation

n	 Adding a Sidebar or a Pull Quote

n	 Inserting a Watermark
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n	 Printing an Envelope

n	 Printing a Mailing Label

n	 Mail Merge: The Power and the Pain

n	 Creating a Form Letter

n	 Finalizing Your Document

Sure, you may use Microsoft Word 2010 most often for letters, 
reports, newsletters, and flyers. But every once in a while, in 

addition to the normal, run-of-the-mill documents you create, 
you may need to do something special—like create a cover 
page for a report, add an equation to a proposal, include cita-
tions listing your references for some research you’ve done, or 
create a professional table of contents so readers can find their 
way through your document easily. Word 2010 includes a wide 
selection of predesigned cover pages that you can use as is or 
customize to better coordinate with your needs. Additionally, 
this section talks about inserting equations, using text boxes to 
create sidebars and pull quotes, and creating watermarks. If your 
document needs footnotes or endnotes, Word not only numbers 
them automatically but updates the numbers for you if you add 
or delete a note, and even figures out their exact placement on 
the page. We’ll also discuss adding citations, creating a table of 
contents, and finalizing your document.

And then there’s the mail merge feature—a great time-saver 
when you need to send the same information to a few individuals 
or to a large group of people. You provide a main document and a 
data source, and Word combines, or merges, the information into 
a new, personalized document or personalized e-mail messages.

6
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2

3

The Multilevel List buttonNumbering Headings and Lines
When you are preparing a document that will be peer-
reviewed (for example, an article for a professional 
journal) or distributed to a team of reviewers who will 
be asked to provide feedback, adding numbers to the 
headings and lines makes it easy for reviewers to com-
ment on the relevant sections. You can add numbers 
to your Word 2010 headings by using the Multilevel 
List tool, and you can control line numbers of text 
using various tools in the Page Layout tab. 

Number the Headings

	 1 	 Verify that you’ve applied the correct styles 
to all the headings.

	 2 	 Click in the first heading paragraph.

	 3 	 On the Home tab, click the Multilevel List 
button, and click one of the heading-
numbering schemes.

	 4 	 Verify that your document headings are 
numbered correctly. If you don’t like the look 
of the numbering scheme, click the Undo 
button on the Quick Access toolbar.

4
If a paragraph that you want to number as a 
heading isn’t included when you use a heading-
numbering scheme, you haven’t assigned it the 
proper outline level. To correct this problem, 
you can either modify the style and assign it the 
correct outline level, or switch to Outline view, click 
in the paragraph, and select the outline level on 
the Outlining tab.

Tip 
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Number the Lines

	 1 	 On the Page Layout tab, click the Line 
Numbers button, and choose the type of line 
numbering you want from the drop-down 
menu.

	 2 	 If you want to change the starting number 
or the interval at which line numbers are 
shown (every fifth line, for example), click 
Line Numbers again, choose Line Numbering 
Options from the menu, and, on the Layout 
tab of the Page Setup dialog box, click the 
Line Numbers button to display the Line 
Numbers dialog box.

	 3 	 Select the Add Line Numbering check box, 
if it isn’t already selected, to turn on line 
numbering.

	 4 	 Specify the options you want.

	 5 	 Click OK, and then click OK in the Page Setup 
dialog box.

If there’s a paragraph whose lines you don’t want 
to be included in the line-numbering process, click 
in the paragraph, click the Line Numbers button 
on the Page Layout tab, and choose Suppress For 
Current Paragraph.

Tip 

The line numbers are visible on your screen only in 
Page Layout view and Print Preview.

Tip 

1

3

2

5
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Inserting a Cover Page
When you’ve spent time and energy making the inside of 
your report look great, you may want to add a professional 
cover page to give the entire document a polished look. A 

well-designed cover page makes a good first impression and 
gives readers important information about what they’ll see 
inside your document.

Insert the Cover Page

	 1 	 On the Insert tab, click the Cover Page button, 
and in the gallery that appears click the cover 
page you want.

	 2 	 Switch to Print Layout view if you aren’t 
already in that view, press Ctrl+Home to move 
to the beginning of your document, click in an 
area that needs to be completed, and type the 
required information. Repeat these actions for 
all the other areas that need to be completed.

3 	 If you’re not happy with the design of the 
cover page, do any of the following:

	 •	On the Insert tab, click Cover Page, and 
choose another design.

	 •	On the Page Layout tab, click Themes, and 
choose a different theme.

	 •	Add a picture, a drawing, fields, text, or other 
items to customize the page.

	 •	On the Insert tab, click Cover Page, and 
choose Remove Current Cover Page to delete 
the cover page.

4 	 Save your document.

13
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Inserting Information with 
Additional Actions 
Word 2010 is a smart program, and it can help you do 
more with the information in your document by pro-
viding action items you can use to carry out specific 
tasks that are tied to the word or phrase. For example, 
suppose that you include the name of a coworker 
in your document. Word 2010 offers an additional 
action when you right-click that enables you to send 
an e-mail message, schedule a meeting, or display the 
person’s contact information. When you right-click a 
paragraph that includes a company name. You can 
specify the actions you want Word 2010 to be able 
to take depending on the type of information it finds 
in your document. In versions of Word prior to Word 
2010, Additional Actions were known as smart tags. 

Contact a Colleague

	 1 	 Look through your document and right-click 
a person’s name.

	 2 	 In the context menu that appears, click 
Additional Actions.

	 3 	 Click the action you want to perform.

Or 

	 4 	 Click Options. 

	 5 	 Click Enable Additional Actions In The Right-
Click Menu if necessary.

	 6 	 Click the check boxes of the items you want 
to include.

	 7 	 Click OK.

3
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Insert the Equation

	 1 	 Click in the document where you want 
to insert the equation.

	 2 	 On the Insert tab, click the down arrow 
at the right of the Equation button, 
and in the gallery that appears click the 
equation you want.

	 3 	 Edit and format the equation as desired.

Or 

	 4 	 Use the tools on the Equation Tools 
Design tab to add to the equation.

	 5 	 Click outside the equation when you’ve 
finished working with it.

Inserting an Equation
If you create documents in which you need to display accurate 
mathematical equations, you’ll be pleased with the equation 
improvements in Word 2010. The enhanced tools now enable 
you to create sophisticated custom equations, choose and 

modify predesigned equations, and add all the elements you 
need to create the equation the way you want it. What’s more, 
you can save your equation to the Equation gallery so that it’s 
there the next time you need it.

2

1

If you add an equation to your document and then 
save it in Word 97-2003 format, the equation will 
be converted to an image and you will not be able 
to edit it. If you convert the document to Word 
2010 format once again, however, you will be able 
to edit the equation.

Caution

4

5
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Adding a Sidebar or a Pull Quote
When you want to add a special design element that rein-
forces key ideas, adds extra information, or spotlights phrases 
in your text, sidebars and pull quotes help you present the  

text in a special way. Word 2010 offers a variety of sidebar and 
pull quote styles you can add for that distinctive look.

Insert a Predesigned Text Box

	 1 	 Switch to Print Layout view if you aren’t already in 
that view.

	 2 	 On the Insert tab, click the Text Box button, and in 
the gallery that appears click the text-box design 
you like.

	 3 	 Select any sample text in the text box, and paste 
or type your replacement text.

	 4 	 Click the outer boundary of the text box, and drag 
it to the location you want.

	 5 	 Use any of the tools on the Text Box Tools Format 
tab to modify the text box itself, or use the for-
matting tools on the Home tab to modify the text.

	 6 	 Click outside the text box to resume working on 
the main content of your document.

To create your own custom text box, click Draw Text 
Box in the Text Box gallery, and use your mouse to 
drag out the dimensions of the text box.

Tip 

You can change the way the text wraps around a text box 
you add by right-clicking the box and choosing Wrap 
Text from the context menu. Click the option reflecting 
the way you want the text to flow around the text box.

Tip 
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Create the Watermark

	 1 	 On the Page Layout tab, click the Watermark 
button, and choose the watermark you want 
from the gallery that appears. 

	 2 	 If none of the existing watermarks is what 
you want, choose Custom Watermark from 
the gallery to display the Printed Watermark 
dialog box.

(continued on next page)

Inserting a Watermark
A watermark is a picture or some text (a company logo, for 
example) that appears subtly “behind” the main text in your 
document. Watermarks can help identify your document as 
your document and give readers additional information about 
how they can use the piece (for example, some watermarks say 

“Do Not Copy.” The watermark in your Word 2010 document 
appears on every printed page as though it were part of the 
paper. You can create a picture watermark or a text watermark, 
but you can’t have both in the same document.

1

5

2

To have the same watermark appear automatically 
in every document that you create using a particu-
lar template, add the watermark in that template. 
To make sure a specific watermark is available 
for all your documents, add it to the Watermark 
gallery.

Tip 
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Create the Watermark  (continued)

	 3 	 To create a text watermark, select Text 
Watermark, type the text, choose your 
formatting options, and click OK.

	 4 	 To create a picture watermark, select Picture 
Watermark, click the Select Picture button 
and locate and select the picture file you 
want to use, choose your formatting options, 
and click OK.

	 5 	 If you decide you don’t want a watermark 
after all, click the Watermark button on 
the Page Layout tab, and choose Remove 
Watermark from the gallery.

3

4

The watermark appears in the Print Layout and Full 
Screen Reading views, and in Print Preview. It also 
appears, of course, in the printed document. 

Tip 
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Creating Footnotes and Endnotes
If you are creating a document in which it’s important to cite 
your references and add notes that support your text, you’ll 
love the footnote and endnote features in Word 2010. Word 
automatically positions footnotes at the bottom of the page or 
places endnotes at the end of the document or section, which-
ever you specify. Word numbers both the footnotes and the 

endnotes, giving each a unique numbering format. Whenever 
you add or delete a footnote or an endnote, Word automati-
cally renumbers the appropriate series. For a footnote, Word 
also figures out how much space is required at the bottom of 
the page for the footnote, and when a footnote is too long for 
the page Word automatically continues it on the next page. 

Insert the Footnote or Endnote

	 1 	 In Print Layout view, with the insertion point 
located where you want the footnote or 
endnote reference mark to appear in your 
document, click the Insert Footnote button 
on the References tab for a footnote or the 
Insert Endnote button for an endnote.

	 2 	 Type your footnote or endnote text.

1 The footnote mark

2
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Change the Reference Mark

	 1 	 On the References tab, click 
the Footnote & Endnote dialog 
launcher.

	 2 	 Specify where you want the 
footnotes or endnotes to appear, 
and click the numbering format 
you want.

	 3 	 Click to display the Symbol dialog 
box, choose a symbol for the 
footnote or endnote reference 
mark, and click OK.

	 4 	 Click Apply to change the location 
of the footnotes or endnotes and/
or the number format, or click 
Insert to use the selected symbol 
as the reference mark for this 
footnote or endnote.

1

2

4

3

Click if you want to convert
endnotes to footnotes, 
or vice versa.
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Inserting a Citation
When your writing references outside sources and/or works 
by other people—including books, articles, legal decisions, 
or other items—you’ll need to cite these sources. Word pro-
vides a rich environment for entering, compiling, formatting, 
and inserting citations into your documents. If you’re working 
in a company, a school, or an agency that frequently creates 

documents that include citations, you probably already have 
the data entered in bibliographies, ready to be dropped in. If 
not, however, you can type the information as you go and save 
it for future documents. You can insert individual citations and 
manage the sources you use as references in your Word 2010 
documents.

Add Existing Citations

	 1 	 On the References tab, click the Manage Sources 
button to display the Source Manager dialog box.

	 2 	 If the default source file isn’t the one you want, click 
Browse. Use the Open Source List dialog box to locate 
the source file you want, and then click OK. You can 
use numerous source files to copy citations into your 
document.

	 3 	 If citations exist in the source document that aren’t 
already in your document, and you’ll eventually want 
to add them, select the citations you want, and click 
Copy. Use the Sort and Search tools if you need to 
find citations in a large source file, and add those you 
want to your document.

	 4 	 Select any citation you’re not sure of to inspect the 
information, and then decide whether or not to add it 
to your document. 

	 5 	 Click Close when you’ve finished.

All citations are tagged as fields, and you can easily 
modify their styles by changing the Citations & 
Bibliography style on the References tab. 

Tip 
If you need to cite a source but don’t currently have the 
citation information, don’t worry. Click in the document 
where you want to place the citation, click Insert Citation, 
and choose Add New Placeholder. When you eventually 
have the information, double-click the placeholder, and 
enter the information in the Edit Source dialog box.

Try This 
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The citation is placed inside a content control in 
your document. To edit the citation or the source, 
or to convert the citation into static text, point 
to the content control, click the down arrow that 
appears, and choose what you want to do from the 
drop-down menu.

Tip 

To edit a citation, double-click it, and change the 
information in the Edit Source dialog box.

Tip 

Insert a Citation

	 1 	 Select the citation style you want for all of 
your citations.

	 2 	 Click in your document where you want the 
citation to appear.

	 3 	 On the References tab, click the Insert 
Citation button, and if the citation you want 
is listed, click it.

	 4 	 If the citation isn’t listed, click Add New 
Source to display the Create Source dialog 
box.

	 5 	 Select the type of citation you want.

	 6 	 Enter the information for the citation.

	 7 	 Either use the proposed citation tag name or 
enter a unique name.

	 8 	 Click OK.

	 9 	 If you want to insert a bibliography of your 
citations or a list of works cited, place the 
insertion point where you want the item to 
appear, click the Bibliography button, and 
click the item you want in the gallery that 
appears.
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Creating a Table of Contents
For long documents, adding a table of contents is a great 
reader service, making it easy for those reading your docu-
ment to turn just the page they want to see. Word 2010 pro-
vides a number of predesigned tables of content so that you 
can choose one you’d like to use or modify it to fit your docu-
ment. Word 2010 will automatically include all headings you’ve 

styled as Heading 1, Heading 2, and so on as it compiles the 
table of contents. After you add the table, you can easily 
update it, change its style, or update only the page num-
bers, which enables you to make sure the table of contents is 
accurate if one or more headings get moved during editing.

Set the Outline Text

	 1 	 In Outline view, scroll through the document, 
verifying that any paragraph you want to 
appear in the table of contents has a style 
that uses the appropriate level 1, level 2, or 
level 3 outline level, and that any paragraph 
you don’t want to include has an outline level 
of 4 or below or a Body Text outline level. 
If a paragraph you want to include doesn’t 
have a style with the appropriate outline level 
assigned to it, click in the paragraph and 
apply the appropriate style. 

(continued on next page)

1
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Set the Outline Text  (continued)

	 2 	 Switch to Print Layout view, and click in 
the document where you want the table of 
contents to appear.

	 3 	On the References tab, click the Table Of 
Contents button, and select the style and 
type of table of contents you want to insert.

	 4 	 If you make changes to the document that 
affect the pagination or the heading con-
tent, click the Update Table button on the 
References tab.

4

3

2

If you want to include or exclude a paragraph but 
don’t want to change its style, click the Add Text 
button on the References tab, and click the outline 
level you want to apply.

Tip

After you’ve added the table of contents to your 
document, you can update it easily by clicking the 
table and pressing F9. Word helps you keep the 
table of contents up to date so that the page num-
bers and headings are correct, even after you’ve 
added text, moved sections around in the docu-
ment, or edited the headings in the file.

Tip 
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Printing an Envelope
Sometimes a printed envelope conveys just the look and feel 
you’re looking for when you send a document. Suppose, for 
example, that you’ve just created a great proposal that you 
want to deliver to a top client. Creating a printed envelope in 
the same font and style as the proposal helps your work look 
consistent and professional. With Word, you can easily create 

crisp, businesslike printed envelopes. You can add your return 
address, and, in the United States, you can add electronic 
postage. If you already have the mailing address in your letter, 
Word usually detects it and copies it to the Envelopes And 
Labels dialog box. You can also type the address directly in the 
dialog box.

Add the Address

	 1 	 On the Mailings tab, click the Envelopes button to 
display the Envelopes And Labels dialog box.

	 2 	 If a delivery address is displayed on the Envelopes 
tab, verify that it’s correct. 

	 3 	 If no delivery address is shown, or if you want to use 
a different address, type the address. If the address 
is in your Microsoft Outlook Contacts list, click the 
Insert Address button.

	 4 	 Verify that the return address is correct. If you’re 
using an envelope with a preprinted return address, 
select the Omit check box so that the return address 
won’t be printed.

	 5 	 Click Options to display the Envelope Options dialog 
box.

(continued on next page)
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Add the Address  (continued)

	 6 	 On the Envelope Options tab, specify the 
envelope size and the fonts and positions for 
the addresses.

	 7 	 On the Printing Options tab, specify how the 
envelope is to be loaded and printed. Click 
OK.

	 8 	 If you have electronic postage (e-postage) 
software installed, select this check box to 
use electronic postage. 

	 9 	 If you need to make changes to your 
e-postage setup, click the E-Postage 
Properties button.

	 10 	 Click Print to print the envelope.

7
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Printing a Mailing Label
Printing mailing labels is much easier than it used to be. Today 
you can purchase labels at almost any office supply store and 
find that you can easily print what you need—one label or 
sheets of labels—in Word 2010. You choose your label type, 
enter the address, and select how you want the label to be 
printed, and Word does the rest. Nice.

Print the Label

	 1 	 Make a note of the manufacturer and the design 
number of the labels you’ll be using. If you’re planning 
to print only one label, figure out which label on the 
sheet of labels is the one you’re going to use. Later in 
the process, you’ll need to specify the label by row (the 
horizontal line of labels) and by column (the vertical 
line of labels). Insert the sheet of labels into your printer 
(usually into the manual feed tray, if there is one).

	 2 	 On the Mailings tab, click the Labels button to display 
the Envelopes And Labels dialog box. 

	 3 	 On the Labels tab of the Envelopes And Labels dialog 
box, use the proposed address, type a new one, or  
click the Insert Address button to insert an address from 
your Outlook Contacts list. To insert your return address, 
select the Use Return Address check box.

	 4 	 If the type of label shown isn’t the one you’re using, 
click Options to display the Label Options dialog box, 
specify the label you’re using, and click OK.

	 5 	 If you’re using a full sheet of labels, click the appropriate 
option to print a whole page of identical labels or only 
one label on the sheet of labels. If you want to print  
only one label, specify the label by row and column.

	 6 	 Click Print to print the label or labels.

Read “Managing Your Contacts“ on pages 296–297 for 
information about adding or modifying address information 
in your Outlook Contacts list. Read “Changing Your User 
Information“ on page 399 for information about modifying 
your return address.

See Also 

If you need to print a large number of different mail-
ing labels, consider using the mail merge feature.

Tip 
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Mail Merge: The Power and the Pain
If you’ve ever had to send the same letter or catalog to more 
than one person, you know what a time-saver mail merge 
can be. Mail merge saves you the trouble of typing numer-
ous names and addresses by merging your contacts list with 
the document you’re creating. In Word 2010, mail merge uses 
a master document and a data source to accomplish the task. 
The master document is the template (although not a tem-
plate in the Word-document sense) that lays out your docu-
ment and contains text or other items that never change. This 
might be the sales letter, for example, that you want to send 
out to all your customers. The master document also contains 
instructions for inserting data from a data source into each doc-
ument. The data source is your contact list, Microsoft Excel 2010 
spreadsheet data, or other file containing the name and address 
information you want to merge with the document.

The goal of mail merge is simple: to produce many differ-
ent documents that are personalized to go to many different 
individuals—without a lot of extra work from you. The process 
of putting together a mail merge document may seem a bit 
complicated at first, but it’s really just a matter of telling Word 
where to substitute the different data items. (For example, the 
name goes here, and the address goes there.) Once you use the 
mail merge feature a time or two, it will seem intuitive. After you 
master the basic mail merge process, you can get a little fancier 
by adding conditional expressions, which enable you to create a 
mail merge letter for a customer if a certain condition is true.

It’s More than Letters

The mail merge feature can do more than create form letters 
and address envelopes. You can save the merged documents 
as a file so that you can edit them or send them by e-mail. You 
can create almost any type of document by using a specific 
template or designing the document from scratch. All Word 

needs is a data document with some data fields in it. You can 
create mailing labels and address books, awards, parts lists, 
different versions of exams, and catalogs designed for specific 
geographical areas or demographic populations. The uses for 
mail merge are limited only by your creativity, your willingness 
to experiment with different data fields and Word fields, and 
your decision as to whether mail merge would be faster than 
manually creating individual documents. 

Setting Conditional Content

Mail merge offers you a flexible way to produce content based 
on what your customers want to see. You can easily tailor the 
content according to the data stored in your mailing list. For 
example, you might offer one promotion to individuals who 
live in the western region, but offer a different promotion to 
those who live in the southern U.S. If you have an entry in your 
data file that tracks the region in which the customer lives, you 
can use that data to control the content of your document. To 
add this kind of conditional content, you use the IF field, avail-
able in the Rules tool in the Mailings tab. You can tell Word 
to insert one set of content IF the contact lives in the western 
region, or insert a different set of content IF the contact lives 
in the southern region.

There’s one change for Microsoft Works users who plan to use 
their Works database as the data source for a Word 2010 mail 
merge. Now you need to export your data and then create a 
new data source before importing the information into Word. 
Word 2010 no longer directly imports Works databases.

Tip 
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Creating a Form Letter
If the idea of creating a form letter sends a shudder of appre-
hension down your spine, relax; it’s no more difficult than writ-
ing a simple note to a coworker. Once you create the letter, 

you can customize it by adding the mail merge fields you 
want—and then it’s just a few short steps to the final merge 
process.

4

1

2 3

5

6

Set Up Your Letter

	 1 	 Create and save your letter.

	 2 	 Click the Start Mail Merge button, and 
choose Letters. 

	 3 	 Click Select Recipients and choose one 
of the following:

	 •	Type New List to enter your data.

	 •	Use Existing List to use data that exists 
in a file Word can read.

	 •	Select From Outlook Contacts to use 
data from your Outlook Contacts list.

	 4 	 Click Edit Recipient List. 

	 5 	 Select or clear check boxes to choose 
recipients.

	 6 	 Click OK when you’ve finished.
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Working with Special Content in Word
Specify the Data to Be Merged

	 1 	 In your document, click where you want to 
add information from your data source.

	 2 	 In the Write & Insert Fields group, click the 
type of information you want to insert. 

	 3 	 In the dialog box that appears, specify 
the options you want, and then click OK. 
Continue adding items to the letter. 

	 4 	 Click Preview Results.

	 5 	 Click to preview the letters.

	 6 	 Click Edit Recipient List to make changes 
to the data list. 

	 7 	 Click Auto Check For Errors.

	 8 	 Click Finish.

3

2

1

6 4 85

7
If you’re familiar with conducting a mail merge 
using the Mail Merge Wizard that steps you 
through the process, and if you want to use the 
wizard, click the Start Mail Merge button, and 
choose Step By Step Mail Merge Wizard from the 
drop-down list.

Tip 
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Finalizing Your Document
Word 2010 includes a Document Inspector that helps you 
assess your document before you send it to ensure that 
you aren’t including any sensitive information—personal or 

business—that should stay inside the company. Additionally, 
the Document Inspector can help you prepare the file for dis-
tribution and ensure that it isn’t edited against your wishes. 

Prepare Your Document

	 1 	 With your document completed and saved, 
click the File tab. 

	 2 	 In Backstage view, in the Prepare For Sharing 
area, click Check For Issues.

(continued on next page)

If you don’t want other people who have access 
to your document to edit it, click File, click Protect 
Document in the Permissions area, and click Mark 
As Final.

Tip 

1

2
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Working with Special Content in Word

To edit a document that has been marked as Final, choose 
Mark As Final again from the Prepare submenu.

Tip 

Read “Password Protecting a File“ on page 409 for infor-
mation about using additional security settings to prevent 
changes to your document.

See Also 

3

4

6

5 

Prepare Your Document  (continued)

	 3 	 In the Document Inspector dialog box, clear 
the check boxes for the items you want to 
keep in the document and select the check 
boxes for the items you don’t want to appear 
in the document.

	 4 	 Click the Inspect button at the bottom of the 
dialog box.

	 5 	 In the Document Inspector dialog box, click 
the Remove All button for each type of item 
you want to remove. 

	 6 	 Click Close when you’ve finished.
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Index
Symbols
* (asterisk)

in calculations, 180, 182
file names and, 26

\ (backslash), 26
^ (caret), 182
= (equal sign), 180
/ (forward slash)

in calculations, 180, 182
in file names, 26

> (greater than), 26
< (less than), 26
– (minus sign), 182
( ) (parentheses), 182
% (percent sign), 182
+ (plus sign), 26, 182
| (vertical bar), 26

A
absolute cell references, 180, 188
Access. See also databases

Access window, 360–361
analyzing data, 388–389
compatibility issues, 30
database basics, 362–363
Datasheet view, 361
exporting data, 376–377
fields and records, 363, 368–372
Form Wizard, 380
forms, 380–382
importing data, 374–375
Navigation Form, 380, 381–382
other file formats and, 367
overview, 5, 359–362

PivotCharts, 388–389
queries, 386–387
Query Wizard, 386–387
Quick Start fields, 369
Report view, 361–362
Report Wizard, 382
reports, 382–385
storing data, 362–363
table relationships, 363, 378–380
tables, 368–369
templates, 364–366
using existing databases, 366–367
views in, 360–362

actions
action items in Word, 125
Actions buttons in PowerPoint, 229
Actions group in Outlook, 346–355
additional actions in Word, 125
assigning to slides, 229
keyboard shortcuts for, 19
order of, 182
redoing, 19
shortcut menus and, 16
undoing, 19

Actions group in Outlook, 346–355
ActiveX controls, 416–417
add-ins, 416–417
addition, 182
address books, 264, 285
addressing

e-mail messages, 264, 295, 297
envelopes, 136–137

aligning objects, 311
in Publisher, 324–326

aligning text
in Excel cells, 162
keyboard shortcut for, 19
in PowerPoint slides, 215

in Publisher, 321, 324
in Word

converting text to tables for, 100
hyphenation and, 103
Linked Styles and, 82
setting alignment, 88
tables, 102

alphabetical sorting
in Excel, 192
in Word lists, 119
in Word tables, 118

animation
in charts, 227
customizing, 228
running in presentations, 250
saving files and, 255
setting effects, 226–227
of slide elements, 226–227
triggering, 208–227

Animation Painter feature, 227
Animation Trigger feature, 227
annotating presentation slides, 251
appointments

adding detail to, 286–287
recurring appointments, 287
reminders for, 287
setting up, 286

arithmetic operators
defined, 182
for formulas, 180
order of precedence for, 182

Artistic Effects feature, 36
asterisk (*)

in calculations, 180, 182
file names and, 26

attendees, for meetings, 294–295
audio

assigning actions and, 229
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audio notes in OneNote, 348–349
presentation narration, 240–241
in presentations, 232–233
in slide transitions, 228, 234
in slides, 232–233

AutoCorrect feature (Word), 71–72
automatic hyphenation (Word), 103
AutoRecover options, 413
averaging a series of calculations, 185

B
backgrounds

in Excel charts, 203
formatting in slides, 212–213
in publications, 311, 322
removing in pictures, 39
styles for slides, 211

backing up files, 413
backslash (\), 26
Backstage view

file and program information, 22
layout and features, 22
overview, 5
printing files from, 23

baselines, in Publisher, 324–325
bold formatting, 19
bound documents, 107
boundaries, object, 324–325
broadcasting presentations, 258–259
browsing for help, 24
Building Blocks feature, 323
bulleted lists (Word)

creating, 96
formatting, 97
styles for, 82

business cards (Outlook)
adding fields to, 302
creating, 302
customizing look of, 285

e-mailing, 302–303
business information (Publisher), 310, 332

C
calculations. See also formulas; functions

cell values, 182–183
order of precedence in, 182
series of, 188
summing data, 181, 184–185

Calendar view, 288
calendars (Outlook)

adding appointment detail, 286–287
controlling access to, 293
overview, 285
publishing to Web, 290
setting up appointments, 286–287
sharing, 290–292
sharing available times, 291

caret (̂ ), 182
case, changing, 19
cell addresses. See cell references
cell references

absolute, 180, 188
in arguments, 187
in calculating values, 183
copying cell content and, 177
defined, 147
determining, 177
in formulas, 180
names instead of, 177
old style of, 177
in printing, 180. See also print areas
R1C1 reference style, 177
in ranges, 177
relative, 180, 188

cell values, 147
cells

conditional formatting, 174–176
defined, 147
deleting content, 159

formatting, 154–155, 162–164
naming ranges of cells, 147
selecting, 154

centered text (Word), 88
changing user information, 399
character styles, 82

in Publisher, 316–317
in Word, 82, 84

charts (Access)
animation in, 227
PivotCharts, 388–389

charts (Excel)
backgrounds in, 203
combining, 206
creating, 202
customizing, 206
data series charts, 206
formatting, 204–205
layouts, 203
line types in, 203
overview, 147, 201–202
PivotCharts, 197
styles, 204
themes, 204–205
3-D effects in, 176–203
types of, 201

citations of sources, 132–133
citing references in Word, 130–131
citing sources in Word, 132–133
clip art

clip art audio, in slides, 232–233
finding and inserting, 40

Clipboard, 20–21, 372
co-authoring

contacting co-authors, 77
editing conflicts and, 76
SharePoint Server and, 6
SharePoint Workspace and, 76
Windows Live and, 76
Word documents, 76

instant messaging and, 77
file changes and, 77

audio, continued
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color
applying to OneNote notebook 

sections, 343
color ranges in cell formatting, 175
in pictures, 36–37
Window’s color schemes, 396–397
in WordArt objects, 47
of worksheet tabs, 164

columns (Access). See fields
columns (Excel)

adding, 158
deleting, 159
freezing, 200
hiding, 160
repeating, 168–169
revealing hidden, 160
separating data into, 194
setting width, 162

columns (Word)
adding to tables, 101
changing number of, 112–113
deleting from tables, 101
flowing text into, 112–113

Columns Wizard (Excel), 194
commands, displaying lists of, 15
comments

in Excel, 170–172
in PowerPoint, 247
in Word, 62

comparing Word documents, 79–80
compatibility

Compatibility Checker, 417
Compatibility mode, 30
Compatibility pack and, 30
with earlier Office versions, 27, 31
Rich Text format and, 27
SmartArt Diagrams and, 31

Compatibility Checker, 417
Compatibility mode, 30
Compatibility pack, 30
computer viruses, 273
conditional content, mail merge, 139

conditional formatting
color ranges for cells, 175
creating rules for, 176
customizing, 176
data bars, 175
defined, 147
highlighting specific cells, 174
icon sets, 175
overview, 174
removing, 176
reports, 385

Conflict task pane (Word), 76
conflicts, in co-authored files, 76
contact information (Publisher), 310, 332
Contact window (Outlook), 297
contacts

addressing envelopes and, 136
business cards, 285, 302–303
business information, 310, 332
contacting colleagues, 125
Contacts folder, 285
e-mail address books, 264
mail merging data from, 139, 140
mailing labels and, 138

Contacts folder, 285. See also Outlook
content controls, 133
contextual spelling errors, 70–71
contextual tabs, 12
contrast, in pictures, 36–37
Conversation view, 267
converting text to tables (Word), 100
copying

Access data, 373
appointments to OneNote, 355
blind carbon copy (Bcc), 265
to Clipboard, 20
data in worksheets, 156
e-mail messages, 277
Excel data, 156, 157, 177
formatting (Word), 95
keyboard shortcut for, 19
sparklines, 178

tables from other databases, 374–375
Word text, 65

copying, multiple items, 21
copying and pasting, multiple items, 21
cover pages (Word), 124
cropping, pictures, 34–35
Cropping handles, 34–35
customizing Office 2010

destination folders, 402–403
editing settings, 398–399
file formats, 402–403
Quick Access toolbar, 394–395
Ribbon, 392–394
spelling and grammar checkers, 400
spelling dictionaries, 401–402
user information, 399
work area, 396–397

cutting
Clipboard options for, 20
Excel data, 156, 157
keyboard shortcut for, 19

D
dark fonts, 86
data analysis, 148
data bars, 175
data labels, 147
data series, 161
data series charts, 206
data sources, mail merge, 139
databases. See also Access

adding data to tables, 372–373
analyzing data, 388–389
basic concepts, 362–363
calculated fields, 370
conditional formatting, in reports, 385
copying and pasting data, 373
copying tables from other databases, 

374–375
defined, 359
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deleting data, 372
exporting data, 376–377
fields and records, 368–372

adding, 369–370, 371–372
creating by typing, 368
defined, 363
naming and renaming, 368, 370
Quick Start, 369
removing, 371–372
re-ordering, 371–372

formatting data, 370
formatting reports, using themes, 384
forms

creating using Form Wizard, 380
navigation, 381–382
simple, 380

importing data, 374–375
opening existing, 366, 367
PivotCharts, 388–389
queries, 386–387
reports, 382
selecting data, 372
setting data type, 370
storing data in, 362–363
table relationships, 378–380
tables, 368–369
templates, creating from, 364–366
undoing operations, 372

Date Navigator feature, 288
dates and times

inserting, 45
meetings, 294–295

deleting
columns (Excel), 159
e-mail messages, 277
Excel worksheet content, 159
Excel worksheets, 165
fields in databases, 371–372
narration from slides, 240–241
records in databases, 371–372
rows and columns (Word tables), 101

RSS feeds, 281
sparklines, 179

Design Checker (Publisher), 333–334
destination folders, 402–403
dialog box launchers, 14
dialog boxes, 17
dictionaries, 401–402
digital certificates. See digital signatures
digital IDs. See digital signatures
digital signatures, 411, 414–415
direct formatting, 82
display settings, work area, 397
division, 182
Document Inspector, 142
documents. See also files

compatibility and, 30–31
converting to 2010 format, 30–31
digitally signing, 415
file formats for, 27
finalizing in Word, 142–143
preparing for review in Word, 122–123
reorganizing in Word, 120

double-line spacing, 19
double-sided documents (Word)

mirror indents in, 92
setting up, 106

double-sided printing
in Publisher, 337
Word page layout and, 104

Draft view (Word), 61
drawing

custom Word text boxes, 127
in OneNote, 346–347, 348
shapes, 43

E
Edit Wrap Points feature, 117
editing settings, customizing, 398–399
effects

animation in slides, 226–228

embossed text, 317
engraved text, 317
outlined text characters, 317
in pictures, 36, 38
shadows, 317
in shapes, 44
in slide transition, 234
3-D effects, 38, 44, 176–203
WordArt, 46–47

e-mail messages. See also Outlook
addressing, 264, 297
attaching files, 272
attachments, opening, 272, 273
blind carbon copy (Bcc), 265
copying messages, 277
deleting, 277
display options, 266, 267
folders and, 277
formatting options, 262, 263,  

274–275
forwarding, 269
HTML format, 274
hyperlinks in, 274
insert tab, using, 263
instant messaging and, 265
locating, 266
managing with Quick Steps, 276–277
marking and unmarking, 277
message text, 265
message window overview, 262–263
moving, 277
opening, 267
receiving and reading, 266–267
replying to, 268
replying to and deleting using Quick 

Steps, 276
Rich Text format in, 274
sending, 264–265
sending pictures, 263
signatures, 278–279
spam and, 264
subject lines, 264, 265

databases, continued
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themes in, 274
using contact information from, 296

e-mailing publications, 336–337
embossed text, 317
emphasis, formatting for, 94
encrypted passwords, 409
endnotes, 130–131
engraved text, 317
envelopes, 136–137. See also mail merge
equal sign (=), 180
equation tool (OneNote), 348
equations

in OneNote, 348
in Word, 67, 126

error bars, in charts, 203
Excel. See also workbooks; worksheets

AutoSum feature, 184–185
calculating values, 182–183
calculations, 186–187
charts, 201–206
Columns Wizard, 194
comments in, 170–172
conditional formatting, 147, 174–176
file formats for, 27
filtering data, 193
formatting features, 154–155
formulas, 180, 189–190
freezing columns and rows, 200
functions, 181–182, 186–187
importing data, 150
navigating worksheets, 151
organizing worksheets in, 164–166
overview, 3–4
PivotCharts, 197
PivotTables, 196–197, 198–199
preparing to print in, 166–168
printing in, 168–170
saving workbooks, 150
selecting entire worksheets, 162
separating data into columns, 194
series of calculations, 185–188
slicers, 198–199

sorting data, 192
sparklines, 147, 178–179
summing data, 184–185
tables, 190–191
templates, 148
terms used in, 147
themes, applying to worksheets, 149
window layout, 146–147
workbook templates, 148
worksheet layout, 147

Excel Web App, 172
exponentiation, 182
exporting Access data, 376–377

F
Fast Search feature, 349
fields, 363
file block behaviors, 407
file formats

Access, other formats and, 367
binary, 27
compatibility and, 27
for Excel workbooks, 27
macro-enabled, 27
Office, 27
for pictures, 33
Plain Text format, 27
for PowerPoint presentations, 27
Rich Text format, 27
setting default formats, 402–403
for Word documents, 27

file names, 26
file permissions, 410–411
file protection levels, 410–411
file validation, 407
files. See also documents

backing up automatically, 413
recovering unsaved, 412

Fill handles, 157, 161
finalizing documents, 142–143

Find and Replace feature, 67–69
first line indents, 92
flowing text. See also wrapping text

into columns in Word, 112–113
in Publisher, 314–315

fonts (Word)
applying stylistic sets, 87
changing, 86
linked styles and, 82
styles for, 82

footers. See headers and footers
footnotes in Word, 130–131
foreign key fields, 378
form letters, 140–141. See also mail merge
Form Wizard (Access), 380
formatting (Access)

data, 370–371
export formats, 376–377
reports, 384–385

formatting (Excel)
cell data, 154–155
cell dimensions, 162–164
charts, 204–205
color ranges for cells, 175
conditional formatting, 147
creating rules for, 176
customizing, 176
data bars, 175
highlighting specific cells, 174
icon sets, 175
numbers, 155
overview, 174
predefined formats, 154
removing, 176

formatting (PowerPoint)
slide background, 212–213
slide content, 215

formatting (Word)
columns, 112–113
copying, 95
direct formatting, 82
fonts, 86–87
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formatting marks, 56, 57
graphics, wrapping text around,  

116–117
headers and footers, 108–109, 115
hyphenation, 103
indenting, 92
line spacing, 89–91
lists, 96–97, 119
Outline view, 120
page layout, 104–107
paragraphs, 88–92
pictures, wrapping text around, 116–117
section breaks, 110, 114
sorting information, 118–119
with styles, 82–83, 84–85
tables, 98–102, 118
tabs for, 93
text, 94–95
themes, 82, 83
viewing options, 80

formatting e-mail messages, 274
text formatting options, 262, 275

formatting restrictions, 410–411
formatting shapes, 44
forms, in Access, 380–382
formulas. See also calculations; functions

arithmetic operators for, 180
cell references in, 180
functions in, 181–182
troubleshooting, 189–190

forward slash (/)
in calculations, 180, 182
in file names, 26

Freeze Panes tool, 200
Full Screen reading view (Word), 60
functions. See also calculations; formulas

arguments in, 187
defined, 181
order of precedence in, 182
selecting and using, 186
series of, 188

G
galleries, 14
grammar

correcting, 71
grammar checker settings, 400

graphics, wrapping text around (Word), 116–117
grid guides, in Publisher, 324–325
gridlines, in Excel, 166, 203
groups, Outlook, 292–293
gutters, 105, 106–107

H
handles

Cropping, 34–35
Fill, 157, 161
Rotation, 37
Sizing, 35, 43, 47

Handout Master view, 209, 220
handouts, presentation, 249
hanging indents, 92
header rows in Word tables, 118
headers and footers

changing, 115
creating, 108–109
dates and times in, 45

help, opening, 19
Help function, 24–25
hiding or minimizing Ribbon, 19
HTML file formats, 27
hyperlinks, in e-mail messages, 274
hyphenation (Word), 103

I
icon sets, 175
importing

Access data, 374–375
Excel data, 150

indenting, 92
InfoPath (Designer and Filler), 11
Ink To Math feature (OneNote), 348
inking

in OneNote, 346–347
in presentation slides, 251

insert tab
in message window, 263
in Ribbon, 12

inserting
blank lines into notes, 301
citations of sources, 132–133
clip art, 40
comments into presentations, 247
cover pages (Word), 124
dates and times, 45
equations in Word, 126
files into tasks, 300
footnotes and endnotes, 130–131
page numbers (Word), 74–75
pictures, 32

into tasks, 300
into e-mail messages, 263
into publications, 318

screenshots, 42
shapes, 43
sidebars and pullquotes, 127
SmartArt diagrams, 48–49
SmartArt feature into slides, 214
sound in PowerPoint, 232–233
tables into slides, 222–223
tabs in Word table cells, 98
watermarks, 128–129
WordArt objects, 46
worksheets, 165

instant messaging, 77, 265
italic formatting, 19

J
justified text (Word), 88, 103

formatting (Word), continued
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K
kerning, 316
keyboard shortcuts

common, 19
for line spacing/paragraph spacing, 91
for navigating through presentations, 250
Ribbon and, 18
Screen Tip feature for, 19

L
landscape orientation, 105
languages

Office 2010 Language Preferences, 11
selecting for translating text, 50

leading (spacing), 89
left-aligned text (Word), 88
ligature styles, 317
line spacing (Word), 89–91
Linked Notes feature, 352–353
Linked styles, 82
list styles, 82
lists (Word)

creating, 96
formatting, 97
sorting data in, 119
styles for, 82

logical tests, 183

M
macro-enabled file formats, 27
macros

macro-enabled file formats, 27
macro-enabled templates, 27
security and, 416–417

mail merge
conditional content in, 139

data sources, 139
form letters and, 140
mailing labels and, 138
master documents, 139
overview, 139
specifying data to be merged, 141

Mail Merge Wizard (Word), 141
mailing labels, 138. See also mail merge
Manage Sources feature, 132
Manage Versions feature, 22
margins

guides for in Publisher, 324–325
setting in Excel, 166
setting in Word, 105

marking and reviewing changes in Word, 
78–79

master documents, mail merge, 139
master pages, 322
meetings, 294–295
Microsoft Access. See Access
Microsoft Clip Organizer, 11
Microsoft Excel. See Excel
Microsoft Office. See Office 2010
Microsoft Office 2010 Language  

Preferences, 11
Microsoft Office Access. See Access
Microsoft Office Communicator, 77
Microsoft Office Excel. See Excel
Microsoft Office Home and Business, 10
Microsoft Office InfoPath (Designer and 

Filler), 11
Microsoft Office OneNote. See OneNote
Microsoft Office Outlook. See Outlook
Microsoft Office Picture Manager, 11
Microsoft Office PowerPoint. See PowerPoint
Microsoft Office Professional, 10
Microsoft Office Professional Plus, 10
Microsoft Office Publisher. See Publisher
Microsoft Office SharePoint Workspace, 11
Microsoft Office Tools, 11
Microsoft Office Upload Center, 11
Microsoft Office Word. See Word

Microsoft OneNote. See OneNote
Microsoft Outlook. See Outlook
Microsoft PowerPoint. See PowerPoint
Microsoft Publisher. See Publisher
Microsoft SharePoint Workspace, 6
Microsoft Word. See Word
Mini Translator, 50–51
minus sign (-), 182
mirror indents, 92
Move group in Outlook, 346–355
moving

to Clipboard, 20
e-mail messages, 277
Excel data, 156
to previous cell in Word tables, 98
tables in Publisher, 321
Word text, 65

multiplication, 182
multisection documents (Word), 74–75

N
naming

cell references, 177
database fields, 368, 370
files, 26
Outlook tasks, 298–299
ranges of cells, 147
worksheets, 164

narration, 240–241
navigating, in Word, 66–67
Navigation Form (Access), 381–382
negation, 182
network projectors, 239
normal styles, 19
notebooks, 342–350. See also OneNote

blank pages in, 345
creating, 342
default templates, 345
filing unfiled notes, 357
section groups, 343–346
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sections, 343
sharing, 342, 350
subpages, 345
templates, pages from, 344–345
typing notes in, 345–350
viewing, 346

notes
Linked Notes, 352–353
OneNote and. See OneNote
in Outlook, 301
speaker notes, in PowerPoint, 244–245
viewing, in PowerPoint, 209

Notes Master view, 209
Notes Page view (PowerPoint), 209
numbered lists (Word)

creating, 96
formatting, 97
inserting unnumbered paragraphs in, 97
styles for, 82

numbering
endnotes and footnotes, 130–131
headings, 122
lines, 123
pages, 74–75
slides, 218

numerical sorting
in Excel, 192
in Word lists, 119
in Word tables, 118

O
objects

aligning on page, 324–325
layering, 326–327
overview, 307–308
positioning on page, 325
repeating, 322
stacking and grouping, 326–327
text boxes, 312–313

WordArt objects, 47
wrapping text around, 328–329

Office 2010
customizing. See customizing Office 2010
new features in, 5–6
overview, 2–5
programs, 11
securing. See securing Office 2010
versions of, 10

Office 2010 Language Preferences, 11
Office Access. See Access
Office Excel. See Excel
Office Home and Business, 10
Office InfoPath (Designer and Filler), 11
Office Mobile, 6, 172
Office OneNote. See OneNote
Office Outlook. See Outlook
Office Picture Manager, 11
Office PowerPoint. See PowerPoint
Office Professional, 10
Office Professional Plus, 10
Office Publisher. See Publisher
Office SharePoint Workspace, 11
Office Tools, 11
Office Upload Center, 11
Office Web Apps, 6
Office Word. See Word
OneNote

audio notes, 348–349
basic features, 341–342
drawing in, 346–347, 348
inking in, 346–347
notebooks in. See notebooks
overview, 5, 339
printing files to, 23
remote access of, 355
saving Outlook data to, 354–355
Search feature, 349
shapes, adding, 347
sharing notebooks in, 342, 350
sharing notes, 352–353
side notes, 356

storing notebooks online, 355
unfiled notes, 357
using Web content with, 350–351
video clips to, 349
window layout, 340–341
working with equations in, 348

OneNote Web App feature, 355
open fonts, 86
order of precedence, arithmetic 

operators, 182
orientation, page

in Excel, 166
in Word, 105, 110–111

Outline view (Word), 61, 120
outlined text characters, 317
Outlook. See also e-mail messages

accounts, 264
appointment management, 286–287
Calendar folder, 285
calendar sharing, 290–292
contact business cards, 302–303
contact management, 296–297
Contacts folder, 285
Conversation view, 267
copying appointments to OneNote, 355
creating signatures, 278–279
e-mail accounts, 267, 282
e-mail address books, 264
e-mail attachments, 272–273
e-mail folders, 277
e-mail message window overview, 

262–263
formatting e-mail messages, 274–275
forwarding e-mail, 269
group schedules, 292–293
instant messaging, 265
LinkedIn and contact information, 297
managing messages, 276–277
managing messages with Quick Steps, 

276–277
meetings, scheduling, 294–295
notes feature, 301

notebooks, continued
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overview, 4, 261, 283–284
receiving and reading e-mail, 266–267
replying to e-mail, 268
RSS feeds and, 280–281
schedule tracking, 288–289
sending e-mail, 264–265
sending task and contact information to 

OneNote, 355
sharing messages with OneNote,  

354–355
social media sites and, 270–271
task management, 298–300
viewing contacts, 285

Outlook Social Connector
adding sites to, 270
overview, 270
viewing social contacts, 271

P
page design (Word), 82
page layout (Word), 104–107
page numbers (Word), 74–75
page orientation

in Excel, 166
in Word, 105, 110–111

paragraph marks, 56, 57
paragraph spacing, 19
paragraph styles, 82
paragraphs, 88–92

alignment of, 88
indenting, 92
line spacing, 89–91
linked styles and, 82
styles for, 82, 84

parentheses [( )], 182
password protecting files, 409
Paste with Live Preview feature, 20, 21, 156
pasting

Access data, 373
Excel data, 156, 157

keyboard shortcut for, 19
using Paste with Live Preview feature, 21

pasting, multiple items, 21
percent sign (%), 182
percentages, 182
permissions

calendar (Outlook), 293
file, 410–411
restricting, 411

photo albums, in PowerPoint, 235
photographs. See pictures
Picture Manager, 11
pictures

applying effects to, 38
Artistic Effects feature, 36
borders, 38
changing size of, 34–35
editing, 36–39
in e-mail messages, 263
file formats for, 33
inserting, 32
of presentation slides, 256
removing backgrounds, 39
resetting, 38
resizing, 35
rotating, 37
styles, 38

pictures, wrapping text around (Word), 
116–117

PivotChart Wizard (Access), 388–389
PivotCharts

in Access, 388–389
in Excel, 197

PivotTables
creating, 196
PivotCharts and, 197
table data and, 191
using, 197
using slicers with, 198–199

playing audio notes, 349
plus sign (+), 182
portrait orientation, 105

PowerPoint. See also presentations
action, assigning, 229
animation in, 226–228
file formats for, 27
Linked Notes feature and, 353
overview, 4, 208
photo albums, creating, 235
presentation options, 238
restricting file access in, 410–411
reusing slides, 219
SmartArt in, 224
sound, inserting, 232–233
tables, creating and inserting,  

222–223
templates, 210
video

applying video styles, 231
editing clips, 231
inserting from files, 230

viewing options, 209
WordArt in, 225

precedence, in Excel calculations, 182
predefined workbooks, 148
presence icons, 265
presentations. See also PowerPoint

adding content, 214
annotating slides during, 251
broadcasting, 258–259
creating, 210–214
creating multiple versions of, 248
custom, 248
customizing, 211, 246
deleting narration, 240–241
dual monitors in, 239
editing, 216–217, 252
file formats for, 27
handouts for, 249
inserting comments, 247
options, 238
packaging, 254–255
pausing, 243
photo albums in, 235
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recording narration for, 240–241
restricting file access to, 410–411
reviewing, 247
running, 250
saving, 255
saving as video, 257
screensavers and, 239
setting up, 211, 239–246
sharing, 252
slide show settings, 260
slide transitions in, 228, 234
slides. See slides
speaker notes, 244–245
templates, 210
themes, 211
timing, 242–243
viewing options, 209

primary key fields, 378
print areas, 168, 169
Print Layout view (Word), 60
Print preview (Word), 61–62
printing

envelopes, 136–137
files to OneNote, 23
mailing labels, 138
PowerPoint handouts, 249
in Publisher, 309, 336–337
speaker notes, in PowerPoint, 245
two-sided in Publisher, 337

program options, adjusting, 398–399
projectors, 239
Protected view, 5

file validation and, 407
publications. See also Publisher

adding text, 312–313
business information in, 310, 332
connecting text boxes in, 315
creating from scratch, 310–312
creating page parts in, 330–332
creating using templates, 308–309
designing look of, 311–312

flowing text in, 314–315
grouping objects, 326–327
guides, for positioning objects in, 324
inserting pictures, 318
layering objects, 326–327
modifying pictures, 318–319
positioning objects in, 324–325
printing, 309, 336–337
ready-to-use elements, 323
repeating objects in, 322
reusing content in, 330–332
reviewing with Design Checker, 333–334
saving content to reuse, 330–332
sending as e-mail, 334–335
stacking and grouping objects in,  

326–327
tables in, 320–321
text effects in, 317
text objects (text boxes) in, 312–313
text styles, 317
text tweaking in, 316–317
undoing changes to pictures, 319
undoing grouped objects, 327
wrapping text around objects in,  

328–329
Publisher. See also publications

Building Blocks feature, 323
business information in, 310, 332
creating publications, 308–310
master pages, 322
objects

aligning on page, 324–325
flowing text around, 328–329
overview of, 307–308
positioning on page, 325
repeating, 322
stacking and grouping, 326–327

overview, 4, 305–307
printing in, 309, 336–337
selecting stacked objects, 327
text objects (text boxes), 312–313

publishing slides, 253

Q
queries, 386–387
Query Wizard (Access), 386–387
Quick Access toolbar, 394–395
Quick Contacts feature, 296
Quick Steps feature, 276–277
Quick Styles feature, 84, 85
Quick Tables feature, 99

R
R1C1 reference style, 177
ragged edges of text, 88, 103
ranges of cells, 177
Really Simply Syndication (RSS). 

See RSS feeds
recording

audio for presentations, 232–233
audio notes, 348–349
narration, 240–241

records, 363
recovering unsaved files, 412
recto pages, 106
recurring appointments, 287
redoing actions, 19
reference marks (Word), 130–131
relational databases. See databases
relational tables. See databases
relative cell references, 180, 188
reminders, appointment, 287
removing. See deleting
repeating columns and rows, 168–169
Report Wizard (Access), 382
reports, 382–385
research feature, 52
resetting pictures, 319
resizing

pictures, 35
tables, 321

presentations, continued
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resolution
changing, 239
Ribbon and, 6

restricting files, 410–411
reviewing co-authored Word file changes, 77
Ribbon

displaying, 13
hiding, 12, 13
insert tab in, 12
keyboard shortcuts and, 18
layout and features of, 12
minimizing, 12, 13
overview, 5
screen resolution and, 6
tabs, 392
tools, adding, 393

Rich Text format
compatibility and, 27
in e-mail messages, 274

right-aligned text (Word), 88
rotating pictures, 37
Rotation handles, 37
rows (Access), 363
rows (Excel)

adding, 158
deleting, 159
hiding, 160
repeating, 168–169
revealing hidden, 160
setting height, 163

rows (Word tables)
adding, 101
deleting, 101

RSS feeds, 280–281
ruler guides, 92, 324–326
rules, formatting, 176

S
safe mode. See Protected view
Save As function, 19

Save Thumbnail check box, 26
saving files

co-authored Word file changes, 77
in earlier formats, 27
to earlier Office versions, 31
keyboard shortcut for, 19
overview, 26
PowerPoint presentations, 255
setting destination folders for, 402–403
setting file formats for, 402–403

Schedule view, 288
screen resolution

changing, 239
Ribbon and, 6

screensavers, presentations and, 239
screenshots, 42
Search feature

in Help, 25
in OneNote, 349

section breaks (Word). See sections (Word)
sections (OneNote)

applying color to, 343
creating, 343

sections (Word)
creating, 110, 114
headers and footers and, 115
page numbering and, 74–75
page orientation and, 110
section breaks, 110

securing Office 2010
ActiveX controls and, 416–417
add-ins and, 416–417
AutoRecover options, 413
digital signatures, 411, 414–415
file compatibility and, 417
file validation, 406–407
macros and, 416–417
overview, 404
password protecting files, 409
Protected view settings, 407, 408
protection levels on files, 410–411
recovering unsaved files, 412

restricting permissions, 411
Trust Center, 405

sensitive information, safeguarding, 142
shadow effect, 317
shapes

applying effects to, 44
cropping pictures to, 34–35
drawing and inserting, 43
formatting, 44
in OneNote, 347

SharePoint
for co-authoring, 6, 76
saving presentations to, 252, 253
SharePoint Workspace, 11
slide libraries and, 219, 253

sharing
calendars, 290–292
co-authoring documents and, 76
e-mail messages with OneNote, 354–355
features overview, 6
notebooks, 342, 350
OneNote notes, 352–353
presentations, 252
with SharePoint. See SharePoint
with Windows Live. See Windows Live

shortcut menus
displaying, 14, 16
keyboard shortcut for, 19

shortcuts, keyboard. See keyboard shortcuts
Show/Hide tool (formatting), 56, 57
sidebars and pullquotes, 127
signatures, digital, 411
signatures, e-mail, 278–279
single-line spacing, 19
64-bit support

in Excel, 148
in Office, 5

sizing
pictures, 35
tables, 321

Sizing handles, 35
slicers, 198–199
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slide libraries, 253
Slide Master view, 209, 220
slide presentations. See presentations
Slide Show view, 209
slide shows. See presentations
Slide Sorter view, 209, 217
slides. See also presentations

adding footers to, 218
animation effects in, 226–228
annotating during presentations, 251
backgrounds, 212–213
changing content, 216
changing order of, 217
creating new layouts, 221
creating pictures of, 256
formatting, 215
inserting tables, 222–223
modifying default layouts, 220
numbering, 218
reusing, 219
saving in libraries, 253
slide transitions, 228, 234
SmartArt in, 224
themes, 211
WordArt in, 225

SmartArt diagrams
compatibility with older file formats, 49
creating and inserting, 48–49
modifying, 49

SmartArt feature
converting text to, 224
inserting into slides, 214

smartphones, Excel and, 172
Social Connector. See Outlook Social 

Connector
social networking, Outlook and. See Outlook 

Social Connector
sorting

alphabetical, 118–119, 192
Excel table data, 191
Excel worksheet data, 192
numerical, 118–119, 192

Word lists, 119
Word table data, 118

sound. See audio
spacing

character spacing in Publisher, 316–317
character spacing in Word, 82

spam filters, 264
sparklines

copying, 178
creating, 178
defined, 147
deleting, 179
editing, 179
overview, 178
styles, 178

speaker notes
creating, 244
printing, 245

special effects. See effects
spelling

correcting, 71–72
dictionaries, 401–402
spell checking, 19
spelling checker settings, 400

splitting windows, 200–201
spreadsheets. See worksheets
status bar, 396
styles (Word), 82–85
styles, in pictures, 38
stylistic sets, 87, 317
stylized text, 46–47
subtraction, 182
SUM function, 181
summarizing data

with PivotTables, 196–197
slicers and, 198–199

synchronous scrolling, 80

T
table of contents, 134–135
tables (Access), 368–369

tables (Excel), 190–191
freezing columns and rows in, 200

tables (PowerPoint), 222–223
tables (Publisher), 320–321
tables (Word)

adding rows and columns to, 101
converting text to, 100
creating from scratch, 98
deleting rows and columns, 101
formatting, 102
header rows in, 118
insert tabs inside cells, 98
modifying appearance of, 99
moving to previous cell in, 98
predesigned tables, 99
sorting data in, 118
styles for, 82

tabs, setting, 93
tasks (Outlook)

assigning to group members, 300
attaching and inserting files, 300
creating, 298
creating task categories, 299
formatting, 300
inserting pictures and diagrams, 300
naming tasks, 298–299
opening tasks, 299
setting due dates, 298–299
task lists, 299

templates
in Access, 364–366
in Excel, 148
file formats for, 27
macro-enabled, 27
in PowerPoint, 210
in Publisher, 308–309

text
converting to tables (Word), 100
fine-tuning in Publisher,  

316–317
in SmartArt diagrams, 49
stylized, 46–47
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translating, 50–51
wrapping. See wrapping text

text boxes
custom, 127
predesigned, 127
in shapes, 44

text effects, 317
text formatting (Word), 94–95
text objects, 312–313
text selection methods, 64
text styles, 317
themes

changing look of, 149
in e-mail messages, 274
in Excel worksheets, 149
in Word, 82, 83

Themes gallery, 14
3-D effects

in charts, 176–203
in pictures, 38
in shapes, 44

time, inserting, 45
times of meetings, 294–295
timing presentations, 242–243
To-Do Bar, 289
toolbars, 15
tools, 15
ToolTip feature, 54
Track Changes feature (Word),  

78–79
transition effects, in slides, 228, 234
translation languages, 50
trendlines, 203
troubleshooting formulas,  

189–190
true/false values, 183
Trust Center

categories, 405
setting file types in, 406–407

two-sided documents (Word)
mirror indents in, 92
setting up, 106

two-sided printing
in Publisher, 337
Word page layout and, 104

typing over text, 63

U
underline formatting, 19
undoing actions, 19, 319
user information, changing, 399

V
values, 147
verso pages, 106
videos

adding to OneNote, 349
copyright laws and, 230
in presentations, 230–231
saving presentations as, 257

View Side By Side tool (Word),  
79–80

viewing options (Word), 80
Outline view, 120

viruses, 273

W
watermarks, 128–129
Web Apps

Excel, 172
OneNote, 355
overview, 6

Web clippings, 350–351
Web content, clipping, 350–351
Web Layout view (Word), 60
Window’s color schemes, 396–397
Windows Live

for co-authoring in Word, 76
for sharing presentations, 252

wizards
Columns Wizard (Excel), 194
Form Wizard (Access), 380
Mail Merge Wizard (Word), 141
PivotChart Wizard (Access), 388–389
Query Wizard (Access), 386–387
Report Wizard (Access), 382

Word
action items in, 125
adding comments, 62
attachments, displaying in e-mail, 62
AutoCorrect feature, 71–72
citations of sources, 132–133
co-authoring documents, 76
columns, 112–113
comparing documents, 79–80
copying text, 65
cover pages, 124
creating new documents, 56–57, 58–60
drawing custom text boxes, 127
editing text, 63
equations in, 67, 126
file formats for, 27
finalizing documents, 142–143
fonts, 86–87
footnotes and endnotes, 130–131
form letters, 140
formatting. See formatting (Word)
grammar, correcting, 71
headers and footers, 108–109, 115
headings, numbering, 122
hyphenation, 103
indenting, 92
ink features in, 62
line spacing, 89–91
lines, numbering, 123
Linked Notes feature and, 352
lists, 96–97, 119
mail merge, 139–141
marking and reviewing changes, 78–79
moving text, 65
Navigation Pane, 66–67
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numbering pages, 74–75
Outline view, 120
overview, 3
page design, 82
page layout, 104–107
page orientation, 110–111
paragraph alignment, 88–92
predesigned tables, 99
predesigned text boxes, 127
printing envelopes, 136–137
printing mailing labels, 138
printing to OneNote notebooks, 353
reading documents, 62
replacing text, 68–69
search options, 67
section breaks, 110, 114
selecting and modifying text, 63
selecting text, 64
SharePoint Workspace and, 76
sidebars and pullquotes, 127
sorting information, 118–119
spelling, correcting, 70–72
standard page set up, 104–105
starting, 56
styles, 82–83, 84–85
table of contents, 134–135
tables, 98–102, 118
tabs, 93
templates, 58–60
themes, 82, 83
Track Changes feature, 78–79
typing over text in, 63
viewing options, 60–61, 80
watermarks in, 128–129
window layout/interface for, 54–56
Windows Live SkyDrive and, 76
wrapping text, 116–117

WordArt feature, 225
WordArt objects

changing colors in, 47
creating and inserting, 46
fine-tuning in, 47

work area, 396–397
workbooks. See also worksheets

defined, 147
digitally signing, 415
file formats for, 27
organizing worksheets in, 164–166
predefined, 148
safeguarding information in, 160
saving, 150

worksheets. See also Excel
adding columns and rows, 158
basic layout of, 147
calculations with functions,  

186–187
cell references, 147, 177
changing order of, 164–165
changing tab colors in, 164
columns and rows, setting dimensions of, 

162–164
comments, 170–172
copying data in, 156
creating subtotals, 194–195
cutting data, 156
data series, 161
deleting, 165
deleting cells, 159
editing data, 152–153
entering data, 148, 150–151
filtering data, 193
formatting cell dimensions, 162–164
formatting numbers, 155
freezing columns and rows, 200
headers and footers, 167–168

hiding, 165
hiding columns and rows, 160
inserting, 165
layout, 169–170
moving data, 156
naming, 164
navigating, 151
organizing, 164–166
pasting data, 156, 157
preparing to print, 166–168
printing, 168–170
ranges in, 177
removing subtotals, 195
replacing data, 152–153, 194
revealing hidden columns and rows, 160
reviewing data in, 200–201
selecting cells, 154
selecting entire worksheets, 162
selecting text in, 153
separating data into columns, 194
series of calculations, 185–188
setting margins, 166
setting page dimensions, 166
sorting data, 192
summing data, 184–185
themes, 149
unhiding, 165
viewing multiple sections, 200–201

wrapping text. See also flowing text
around clip art, 41
around graphics and pictures, 116–117
around objects, 328–329
around text boxes, 127
in Word, 57

X
XML file formats, 27

Word, continued
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